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PHOTOSHOP BASICS FOR PHOTOGRAPHERS 

Going from Lightroom to Photoshop 

Carry out your normal post processing in Lightroom. 

If you don’t intend to carry out sharpening in Photoshop then do your normal sharpening in 

Lightroom before moving over to Photoshop. 

If you intend to do the sharpening in Photoshop then don’t do any in Lightroom otherwise you end 

up with double sharpening and it can look over sharpened. This document doesn’t include anything 

on sharpening in Photoshop as there are several methods available together with various “Plug-Ins” 

so this will be in a separate document. 

Opening Photoshop 

In Lightroom with the photo selected and shown in the Loupe View, Right Click on the image and a 

menu will pop up. 

Go to “Edit in” and a sub-menu will appear and select “Edit in Adobe Photoshop 2020” (or whatever 

version you have), which will be the top item. The selected photo will open in Photoshop. 

 You can get to the same place using the Main Photo Menu on the top menus, then “Edit in” and a 

sub-menu will appear and select “Edit in Adobe Photoshop 2020”. 

You can open Photoshop directly from desktop and then use “Open” button to browse but it’s better 

to go from Lightroom to keep your images in the same place so when you save in Photoshop the 

photo automatically goes back to Lightroom and appears next to your original photo but with a Tiff 

file tail. 

When working in Lightroom the photo may have been a RAW file but when it moves over to 

Photoshop its no longer a RAW file. 

After you have carried out your Photoshop adjustments just go to the “File” menu on the top line 

and select “Save” and your photo will be saved and it will save it as a Tiff file back in Lightroom to 

the left of your original photo. Don’t use “Save As” or change the file name just use “Save”. 

If you want to carry out some more Lightroom edits you can. 

Then if you want to go back into Photoshop just repeat the steps above but when you say open in 

Photoshop a dialog box opens with three selections. If you want to get back to your Photoshop 

layers etc select “Edit Original”. 
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If you have carried out some Lightroom adjustments since coming out of Photoshop that you don’t 

want to lose or you are working on a JPEG, select “Edit a Copy with Lightroom Adjustments” and a 

copy will be made as it transfers and your second set of lightroom adjustments will be retained but 

the image layers will be flattened so it will appear as a single layer in Photoshop. 

Setting up Lightroom Preferences to ensure the files transfer correctly 

Under the “Edit” menu in Lightroom select “Preferences”. 

Go to “External Editing” and make sure the following is set: -.  

File Format: Tiff 

Color Space: ProPhoto RGB (This is the default but you could select Adobe RGB) 

Bit Depth: 16 bits/component 

Resolution: 240 

Compression: Zip 

Then close this. 

Go over to Photoshop and go to the “Edit” menu and select “Color Settings”. Then select “North 

American General Purpose 2”. Leave the rest as the defaults. Then close this menu. 

Layers 

Layers are probably the most important part of Photoshop and how they can be adjusted is what 

makes Photoshop such a powerful programme. 

To copy the current layer press Ctrl J. To create a new layer, click on the new layer icon on the 

bottom right. 

As Layers is such a large and important part of Photoshop there is a separate document on this that 

goes into a lot more detail. 

However, we need to understand the basics of layers to ensure you have a non-destructive workflow 

as it’s better to carry out adjustments on a new layer rather than the original layer. 

There are two ways to do this. The first is with the original layer selected (which it will be 

automatically when first opening Photoshop from Lightroom) press Ctrl J (Command J on a Mac). 

This will create a duplicate layer above the original and you can work away on this duplicate layer 

and if you don’t like the result you can simply delete it and the original layer is still there. 

The second method is to create a new layer by clicking on the new layer icon (the page with the 

bottom left corner folded back) on the bottom right next to the trash can, which will place a 

transparent layer above the original. Then any changes you make, such as with the Spot Healing 

brush, are on this new layer and the original layer is not changed. Ensure that “Sample All Layers” is 

ticked up near the top row so Photoshop can see the layers below so it knows what you are working 

on. 
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Using the Photoshop tools down the left hand-side 

In the default layout all the main menu items are along the top, the “Tools” are shown down the 

left-hand side of the main viewing screen and the layers and adjustments are on the right-hand side. 

If you hover the curser over a tool a description of the tool pops up. 

Some tools have several types / options to choose from. Hold down the small triangle at the bottom 

right of the tool to open up the various sub-tools. 

Each tool has a shortcut key and this is shown in (  ) after the name of the tool. For example, B is the 

Brush tool and J is the Spot healing brush tool. However, this only opens the first brush in the list or 

the one you were using last. Use shift with the letter to scroll through the various sub-tools. 

Each tool has a “Learn how” help button. Click on this and follow the tutorial which will show you 

how the tool works using an interactive guide. 

A selection of tools that are commonly used 

Move Tool (V) 

Rectangular Marquee Tool (M) 

Lasso tool (L) 

Quick Selection tool (W) 

Crop tool (C) 

Spot healing brush tool (J) 

Brush tool (B) 

Clone Stamp tool (S) 

Eraser tool (E) 

Dodge tool (& Burn tool) (O) 

Text tool (T) 

Hand tool (H) 

Foreground & Background colour (D to reset) 

The letter in brackets is the key to press to bring up the tool rather than clicking on it. I give some 

brief information on the tools most commonly used in photography to remove distractions below. 

If you make a mistake you can use Edit / Undo or Ctrl Z and this steps back once for each press. You 

can just keep pressing Ctrl Z to delete several errors. For a lot of steps back you could go to History 

Panel and select a point where you think all was ok and start again from this point. 
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Removing Distractions 

This is probably, as a Photographer, the area of Photoshop you will use the most. 

Always work on a new layer whenever you can. This ensures you can recover from any errors. 

When using any of the tools make sure as noted above that “Sample All Layers” is ticked if using a 

new transparent layer. 

Work in small pieces rather than a large area. This means stepping back with Ctrl Z only deletes the 

last small piece not a large amount of work. The tools sometimes work better when changing a small 

area rather than a large area. This is not always the case but it usually is. 

The other reason is for example, if you had been carefully removing a long flower stalk and it was 

perfect until the very last bit. You either have to delete the whole thing or try to correct your error. If 

you have done this in small increments you can just delete the last one. 

Content aware doesn’t always work the first time. If it doesn’t look ok step back and repeat until you 

are happy with the result or the result can easily be corrected using another tool. Alternatively, don’t 

step back but just run it several times until you are happy. Content Aware has become much better 

in the more resent versions of Photoshop. However, it seems to do the fill differently each time so 

experiment. 

To use Content Aware Fill, make a selection with say the Lasso Tool and then in the Edit menu select 

Fill which opens the Fill menu and you can select Content Aware Fill in the top box. On the newer 

versions of Photoshop, you have Content Aware Fill as a direct selection within the Edit menu and I 

use this. 

A little more detail on four commonly used tools 

 Spot Healing Brush Tool & Healing Brush Tool 

These work in similar ways. They work so much better than the same tool in Lightroom or Camera 

Raw. 

If you are removing sensor spots the its ok to work on the original layer as its very unlikely that you 

will ever want to bring them back. However, the textbook way is to create a new layer to do this but 

I have to say I very rarely do for sensor spots but I do for other types of corrections. 

For spots not surprisingly its best to generally use the Spot Healing Brush Tool. This brush 

automatically searches the surrounding area for its sampling. If using a new layer remember to have 

Sample All layers turned on. 

As these are brushes you can click on the brush icon to change the settings. For spot removal have a 

50% - 75% Hardness setting but you can experiment to see what works best. If the brush is too hard 

you may see the outline of the repair, too soft it may still show some of the spot and not blend in 

properly. 

You can change the brush size in this brush menu panel but its usually easier to use the [ or ] bracket 

keys. 
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Leave blend mode as Normal; Leave Type as Content Aware; 

If the spots are hard to see try inverting the layer by pressing Ctrl I at the same time and it inverts 

the layer, sometimes making the spots earlier to see. Ctrl I to flip back. 

The difference with the Healing Brush Tool is you select the area to use to heal the imperfection by 

Alt + Click, i.e. holding down the Alt key when clicking (Option + Click on Mac). 

This means you can be more selective in what Photoshop uses to heal the issue. You will see a 

crosshair showing where the brush is sampling from as you go. 

Be careful not to let the crosshairs stray into other areas or off the edges of the photo. The crosshair 

will also see the original image below and will use this which may not be what you want. You can see 

the sample in the brush so keep a close watch on what’s shown in the brush. 

This means you may have to do this in very short strokes. Every time you release the mouse the 

crosshair returns back to its original starting point. You can re-select the sample point at any time to 

get the correct blend to the repair. 

To avoid the crosshair returning to the original sample point you can tick Aligned Sample and the 

sample point will be linked to the brush even after releasing the mouse. This means the sample will 

be the same point away from the brush as the first selection. I personally don’t use this feature very 

often. 

Once finished you can reduce the opacity of the layer to make the corrections blend in a bit better or 

make them look more realistic. This is a good reason to use a new layer. 

If the tool does not seem to be working make sure the layer is selected (not any mask) also make 

sure you haven’t got Caps Lock selected on the keyboard because if you have you will only get a 

crosshair curser not a circle. This also applies to the next tool the Clone Stamp Tool. 

Clone Stamp Tool 

The Clone Stamp Tool requires you to sample just like the Healing Brush Tool. Also, the sample is 

visible within the brush circle. 

The Healing Brush Tool tries to blend the brush into the surrounding areas, whereas the Clone Stamp 

tool doesn’t it just copies exactly what the sample shows. 

Sometimes the Healing Brush Tool in trying to blend in creates some odd issues. This is when the 

Clone Stamp Tool is better as it just copies so you are in control of what the result is rather than 

Photoshop trying to guess what is required. 

 The Clone Stamp Tool also works better on edges or extending features. If you are trying to remove 

a mast from the top of a building when the healing Brush meets the building it tries to alter it as well 

often with odd results. The Clone Stamp Tool doesn’t do this as it’s not trying to blend in just copying 

pixels. 
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When using the Clone Stamp Tool vary the hardness of the brush for the various areas you are 

working on. For example, when getting close to an edge make the brush harder so it doesn’t spill 

over onto the edge. You may then have to soften the brush to paint out any hard edges to the brush 

stroke. 

The downside of the Clone Stamp tool is you have to be careful of the selection both in colour, tone, 

brightness, etc to get a good match. You can alter the opacity of either the brush, as you are using it 

or the layer itself to help blend in the change. 

If you sample an angle of an edge you can change this angle in the Clone Source Panel, which is in 

the same location as the Brush panel just to the right and looks like a darker version of the Clone 

Stamp tool. This is also accessible from the Window menu. 

The sample in the Clone Stamp Tool is actually the full image just clipped to the size of the brush and 

therefore you can manipulate it. 

You can change the angle of the sample using the box below the W & H boxes by holding down the 

left mouse button and dragging left or right. When you do this the whole image is shown but when 

you let go it just shows the clipped sample in the brush. Enlarge the brush if you want a clearer idea 

of the angle of the sample. 

It may be that once the edge has been dealt with you could swap to the Healing Brush Tool for the 

other areas. 

You can sample from one open photo onto another open photo (i.e. two separate open documents) 

as the Clone Stamp Tool remembers the sample point. 

Patch Tool 

This is the third tool in the Spot Healing Brush Tool icon. Click and hold the little triangle on the tool 

icon until the list of tools appears and select the Patch Tool, which unsurprisingly looks like a patch. 

If you had the Spot Healing Brush selected click Shift J twice to get to the Patch Tool. Shift J cycles 

through the group of these tools. 

You click and drag a selection like the Lasso Tool then click and drag the selection to where you want 

the replacement to come from and release the mouse.  

You have to deselect the selection by pressing Ctrl D (I.e. both keys at the same time) (Command D 

on a Mac). 

There are two settings Normal and Content Aware and you can try both to see which works the best. 

Often Normal works best especially if there is a lot of texture as Content Aware tries to bring in some 

of the original area which can look very odd. 

Normal has to be used on an original layer as it doesn’t work on a new transparent layer. Content 

Aware does work on a new transparent layer so if you use Content aware on a new transparent layer 

make sure Sample All Layers is ticked. If you use Normal create a copy layer by pressing Ctrl J 

(Command J on a Mac) so the original layer is maintained just in case you want to go back. 
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There is a setting called Diffusion which works like feathering around the edges. Again, play around 

with the various values to see which blends the edges in best. A setting of 2 can work quite well in 

many cases but if you are working on a portrait it maybe that 6 works best here. 

The Structure setting can be changed after the patch is in place but still selected. Select it and move 

the slider to see the impact. It generally gets looser the higher the number so 1 is the best place to 

start. 

The Colour setting works in a similar way but with zero the best place to start.  

The Use Pattern setting is usually best left as a White Square with a pattern running diagonally 

across it. Try the other settings to see the result. 

The more recent versions of Photoshop have a box near the top where you can choose Source or 

Destination. These work in reverse. 

If you select Source the area you initially select will be replaced by the area you drag the selection 

to. If you select Destination the area you drag the selection to will be replaced by the area you 

selected. I generally use Source. 

Just a note that you could make a selection with the Lasso Tool and then select the Patch Tool and it 

still works on the selection. 

Remember you can always use the layer Opacity slider to blend things in as well and this is the 

reason for doing things on a separate layer so you have this control as well as the various blend 

modes. 

It’s worth trying all four of the above tools (Spot Healing Brush, Healing Brush, Clone Stamp, Patch) 

to see which works best and it will probably be a combination of them to suit each situation. 

Another quick point. If you want to go back to the original and discard all the healing, closing and 

patching just go to the File Menu and select Revert. 

Adjustment layers 

Generally 

Select an “Adjustment layer” by clicking on the icon on the bottom of the layers panel. 

There are a wide range of adjustments available, the most common two are listed below. 

Brightness / Contrast 

Click on brightness / contrast. 

Then click “Auto” button. If results are not quite right adjust the sliders to suit. 

Also, opacity can be adjusted by the % slider 

Hue / Saturation 

Select Hue / Saturation, then adjust in the same way as with the Brightness / Contrast adjustment 
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Other adjustment layers 

Experiment with the other adjustment layers and you will find some work in a similar way to the 

tools in Lightroom. The advantage here is they are on a separate layer so can be manipulated 

separately. 

Masks 

There are two types of masks, Adjustment Layer Masks & Layer Masks 

Layer masks 

These are used on image or pixel layers. 

When you create a new layer or copy an existing layer a mask is not automatically created. 

To add a mask to a layer, click on the Add Vector Mask icon (a white rectangle with a black circle in 

the centre, in the bottom right). 

The mask created will be white so everything on the masks own layer is visible and everything on the 

layer below is hidden. 

On a normal white layer mask (which is the default position) painting on the mask with a black brush 

will conceal / hide the information on its own layer and expose the information on the layer below. If 

you go too far paint with a white brush to reinstate the white mask and this will reveal the 

information on its own layer again and hide the information on the layer below. 

If you invert the mask by pressing Ctrl I it turns black so its own layer is fully concealed but 

everything on the layer below is revealed. Then you use a white brush to reveal information on the 

masks own layer and conceal information on the layer below. 

The phrase “Black reveals / White conceals” is often used to describe this. However, this phrase 

applies to the layer the mask is associated with, NOT layers below. Therefore, the better way to 

remember this is “White reveals its own layer” / “Black conceals its own layer”. (i.e. White makes the 

layer visible, black makes the layer invisible). 

Layers and masks are the most important things to learn about photoshop. It’s worth practicing on a 

couple of layers with a mask and painting on the layers with coloured brushes and then painting on 

the masks to see what happens. This is the best way to understand how layer masks work. 

To hide things on the layer and reveal the layer below, select the mask to ensure the correct layer 

mask is selected and a white boarder will be around the mask thumbnail. 

Select a Brush Tool from the tool menu on the left. Select a soft edge brush and size as appropriate 

on the options bar. The square bracket “]“ makes the brush larger and the “[” makes the brush 

smaller. 
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Ensure black is on top on the two squares on the bottom of the tools panel. If not click on the bent 

double headed arrow to swap them (or press X to swap them around). If the foreground colour is 

not white or black click on the very small symbol to the left of the bent double headed arrow and 

they should revert to black and white (or Press D and it will revert to Black & White). 

Then just paint over the image (not the mask) with the black brush to make this layer invisible and 

allow the layer below to show through. 

If it’s not working the most common mistakes are that the mask is not selected or you are using the 

wrong colour. 

If you go too far change the brush to white and paint back over the black brush marks as this will 

reveal the change again. 

You can reduce the opacity and flow of the brush to reduce the effect and blend it in. 

Adjustment layer masks 

When opening an Adjustment layer a mask is automatically created and opened with it. 

On the right of each layer icon (when using adjustment layers) in the layers panel is a white square 

which is the “Mask” for this adjustment layer. 

When using adjustment layers all the changes you make are visible on the layer below because the 

mask is white. Ctrl I will invert the mask to black so nothing of the adjustment shows though. 

If you do not want the adjustment to be visible in selected parts of the layer below you need to turn 

these selected areas of the white mask black. 

As noted above the standard rule is that Black on a White mask conceals the information on its own 

layer, therefore the adjustment on this layer is made invisible by the black brush. 

Click the mask to ensure the correct layer mask is selected and a white boarder will be around the 

mask thumbnail. 

Select a Brush Tool from the tool menu on the left. Select a soft edge brush and size as appropriate 

on the options bar. The square bracket “]“ makes the brush larger and the “[” makes the brush 

smaller. 

Ensure black is on top on the two squares on the bottom of the tools panel. If not click on the bent 

double headed arrow to swap them (or press X to swap them around). If the foreground colour is 

not white or black click on the very small symbol to the left of the bent double headed arrow and 

they should revert to black and white (or Press D and it will revert to Black & White). 

Then just paint over the image (not the mask) with the black brush to stop the changes made by 

these adjustments affecting those parts of the image on the layer below this adjustment layer. 

As before, if it’s not working the most common mistakes are that the mask is not selected or you are 

using the wrong colour. 
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If you go too far change the brush to white and paint back over the black brush marks as this will 

reveal the change again. 

You can reduce the opacity and flow of the brush to reduce the effect and blend it in. 

This is just a brief look at Photoshop layers and masks and there is another document which goes 

into these in more detail.  

 


